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1 
 
Welcome to Microsoft Outlook 2007! 
 
Microsoft Outlook lets you send and receive e-mail messages, schedule appointments, 
and organize your contacts and addresses. It also reminds you of tasks you need to 
complete.  
 
This chapter introduces the Outlook fundamentals. Besides learning how to start 
and exit the Outlook program, you will learn how to find your way around the 
Outlook screen and item windows. You will also learn how to use keyboard 
commands and access Outlook’s help features. Let’s get started!
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What’s New in Outlook 2007  
Here are some of the items in Outlook 2007 that are somewhat different from previous versions.   

Instant Search   Office Outlook 2007 provides a new fast way to find your information, no matter which folder it is in. Outlook now 
uses the same search technology that Microsoft Windows does, to deliver fast results regardless of mailbox size. In 
addition, an improved visual design displays each individual result of your search immediately, as soon as it is available, 
while the search is still running. Search now appears in the same place no matter where you are in Outlook. You can also 
forward your search query to Windows Desktop Search for a broader search of your entire computer.  

Color Categories   New Color Categories give you a quick, visual way to customize items and to distinguish items from one 
another, making it easy to locate information. Suppose, for instance, that you want to assign a color category to all items 
related to a certain project. You can add the same color category to e-mail, calendar, and task items so that you can easily 
locate all items from that project at a glance. When you need to find the information later, you can search and sort by Color 
Categories to quickly and visually identify what you are looking for.  

Attachment previewing   Using the new Attachment Previewer, you can view your attachments from within the Reading Pane by 
making only a single click. This improvement saves you time and allows you to view attachments in context with the e-mail 
message.  

Minimized Navigation Pane   The Navigation Pane can now be minimized into a vertical button bar, to provide you with a larger 
work area while allowing quick access to Favorite Folders and other views.  

Week view changed in Calendar   Office Outlook 2007 features a new week view. The former week view was a two-column 
layout of days, similar to a day planner. The new week view is similar to the work week views in previous versions.  

Flagging mail for follow-up   Flags are now more useful throughout Outlook. You can use a flag to quickly create a follow-up item 
that can be tracked in the To-Do Bar, in your Inbox, and even in Calendar. They are also still handy for setting reminders 
for yourself and other people.  

Task integration on the Calendar   Office Outlook 2007 integrates tasks on the calendar into the Daily Task List so that you see 
them displayed beneath your daily appointments and meetings. To allot time for working on a task, you simply drag the 
task onto your calendar. When you complete a task on a given day, the task sticks to that day, providing a visual record of 
the work that you performed. Tasks that you do not complete roll over to the next day, and accumulate until you mark them 
as complete.  

Improved scheduling capabilities   Improved scheduling capabilities in Office Outlook 2007 and Exchange 2007 help you to 
schedule meetings easily and in less time. When you use Exchange 2007, attendee schedules are reviewed, and an ideal 
meeting time and location is recommended. A number of other improvements in Office Outlook 2007 make the calendaring 
experience easier for people who are using Exchange 2003 or Exchange 2007. When changes are made to the meeting 
location or agenda, attendees receive an informational update, rather than having to reaccept the meeting. Additionally, 
changes are highlighted in the meeting update, making it easier to locate the information that has been modified.  

Really Simple Syndication (RSS) Feeds   RSS Feeds provide a convenient way for content publishers to distribute information in 
a standardized format. A common example of RSS content is the sources for information that is updated frequently, such 
as news headlines and personal Web logs (called blogs). The benefit of RSS is the aggregation of all content from multiple 
Web sources in one place, along with not having to provide your e-mail address to content publishers to receive the 
information. You no longer have to visit various Web sites to obtain the latest information on your topics of interest.  

Calendar Snapshots   You can send your calendar to anyone in an e-mail message. The recipient can open the calendar either in 
their Web browser or in Outlook.  

Calendar overlays   Viewing calendars in overlay mode enables you to navigate multiple calendars on top of one another, making 
it easier to compare your calendar with a coworker's or team calendar to find a free time to meet.  

Electronic Business Cards   You can create and share customized Electronic Business Cards, which provide a personalized way 
to communicate your information. You can share your card either as an attachment or as part of your e-mail signature. 
Electronic Business Cards allow you to customize your contact information, and also to add logos and photos, making 
contacts more personally relevant and easier to locate. Electronic Business Cards can be exchanged easily through e-mail 
messages, and can be saved to your Contacts folder.  

Out of Office Assistant   Previously, when you started Outlook, and your Out of Office Assistant was turned on, an information 
alert dialog box appeared. In Office Outlook 2007, when you have Out of Office auto reply turned on, a notice appears on 
the status bar. When you use an Exchange 2007 account, you can now schedule your Out of Office times in advance and 
not have to worry about forgetting to turn the Out of Assistant on or off. Additionally, when you use Exchange 2007 e-mail 
accounts, you can specify separate messages for recipients who are inside your organization and those who are outside of 
it. 

Unified messaging   Using Exchange 2007, you can have voice mail and faxes delivered to your Office Outlook 2007 Inbox.  
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Understanding the Outlook 2007 Program Screen  

The Outlook 2007 pro gram screen may seem confusing and overwhelming at first. This lesson will help you become familiar 
with it.  

 

 
 

Title bar: Displays the name of the program you are currently 
using (Outlook) and the item you are currently working with 
(Inbox).  

 Close button: Click the close button in the Title bar to exit 
the Outlook program.  

 
 

Menu bar: Displays a list of menus that you use to give 
commands to Outlook. Clicking a menu name displays a list of 
commands—for example, clicking the Edit menu name displays 
different editing commands like Cut and Paste.  

 To-Do Bar: Keep tabs on your calendar, appointments, and 
tasks all in one place. The To-Do Bar can also be displayed 
in a minimized format.  

 
 

Standard toolbar: Contains buttons for common commands 
such as creating new items, printing items, and getting help. The 
buttons on the Standard toolbar change depending on what 
you’re working on.  

 Status bar: Displays messages and feedback.  

 
 

Inbox: Folder that displays your incoming e-mail messages.   Navigation Pane Buttons: Click a button to see the folders 
and tools for a certain category—i.e. Mail, Calendar, or 
Contacts.  
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Understanding Items  
In Outlook, an item is the basic element that holds information. Items are used to send and view e-mails, and also to 
organize information like tasks and contacts.  

Since they present different types of information, different types of items differ in their appearance.  

Outlook Items provides an overview of items available in Outlook.  

 

Mail Message Compose a message to be sent by e-mail. 

Appointment Add an appointment to your calendar. 

Meeting Request 
Set up an appointment to which you invite other people or reserve resources such as a conference 
room. 

Contact Enter information about a person including their name, company, job title, and e-mail address. 

Distribution List Create a collection of contacts that allows you to quickly send mass e-mails. 

Task Enter to-do items that can be tracked until completion. 

Task Request Inform someone else of a task you would like them to perform. 

Journal Entry 
Keep track of interactions and files that you create—such as e-mails or Word documents—in a 
timeline view. 

Note Leave yourself a note so you remember to do something. Can be sorted using color categories. 

 
 

 
 

Instant Search: Enter key words to perform a search of message 
content and folders.  

 Navigation Pane: Contains buttons and icons you can click 
to move among Outlook’s folders and tools. The pane’s 
contents change when you click a different Navigation Pane 
button—i.e. Mail, Calendar, or Contacts.  

 
 

Reading Pane: Displays the selected message.   
Mail folders: Displays all your mail folders, including the 
Inbox, Outbox, Junk E-mail, Drafts, and Sent Items folders. 

 
 

Help text box: Type a question about Outlook here and press the 
<Enter> key to search Outlook Help for answers. The Outlook 
Help window displays the results.  

 Scroll bars: Use the vertical scroll bars to view different 
parts of the panes.  
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Understanding the Message Window  
The mail message window, like other item windows in Outlook 2007, features the new Ribbon in place of menus and 
toolbars. This lesson will help you become familiar with the basic features of the message window.   

 
 
 

 
 

Office Button and Quick Access Toolbar: The Office Button 
allows you to see everything you can do to your document. The 
Quick Access Toolbar contains common commands such as 
Save and Undo. You can add more commands as well.  

 Send button: Click here to send the message once you’ve 
finished composing it.  

 
 

Ribbon: The tabs and groups of commands on the Ribbon 
replace the menus and toolbars found in the message window in 
previous versions of Outlook.  

 Message Area: Type your e-mail message here as you 
would using a word processor.  

 
 

Recipients: Enter the e-mail addresses of the recipients in the To 
field. Use the CC field to send a copy of the message to any 
recipients who are not directly involved, but who might be 
interested in the message.  

 Signature: You can create a customized signature that 
appears on your messages. You can include contact 
information and even a logo.  

 
 

Subject line: Enter a title here so that recipients quickly know 
the reason for your e-mail.  

 Scroll bar: Use the scroll bar to view different parts of a 
long message.  
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Understanding the Ribbon  
In most of the Office 2007 programs, menus and toolbars have been completely replaced by the Ribbon. Outlook 2007 is 
different. Menus and toolbars remain on the Outlook 2007 program screen, while the new Ribbon appears only in item 
windows such as message windows. The Ribbon keeps commands visible while you work instead of hiding them under 
menus or toolbars.   

The Ribbon is made up of three basic components:  

Tabs   
Commands are organized into tabs on the Ribbon. Each tab contains a different set of commands. In Outlook, there are 
two different types of tabs:  

 Command tabs: These tabs appear by default whenever you open an item window. For example, in a new 
message window, the Message, Insert, Options and 
Format Text tabs appear by default.  

 Contextual tabs: Contextual tabs appear whenever you 
perform a specific task and offer commands relative to 
only that task. For example, if you insert a table in a 
message, the Design and Layout tabs appear on the 
Ribbon.   

Button  Group           Dialog Box Launcher  

Groups  
The commands found on each tab are organized into groups of related commands. For example, the Basic Text group 
contains commands for formatting message text. Click the Dialog Box Launcher ( ) in the bottom-right corner of a group to 
display even more commands. Some groups also contain galleries that display several formatting options.  
 

Buttons  
One way to issue a command is by clicking its button on the Ribbon. 
Buttons are the smallest element of the Ribbon.  

Tips  

 You can minimize the Ribbon so that only tab names appear, 
giving you more room in the item window. To do this, 
double-click the currently displayed command tab. To 
display the Ribbon again, click any tab.  

 Based on the size of the item window, Outlook changes the 
appearance and layout of the commands within the groups.  

 

      Command tab  Contextual tab         
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Using the Office Button and Quick Access Toolbar  
Near the Ribbon at the top of an item window are two other tools you can use to give commands in Outlook 2007: The 
Office Button and the Quick Access Toolbar.  

Office Button  
The Office Button appears in the upper-left corner of an item window and contains basic file management commands 
including New, which creates a new item; Save, which saves the current item; and Close, which closes the currently 
opened item.  

Tips  

 The Office Button replaces the File menu found in item 
windows in previous versions of Outlook.  

Quick Access Toolbar    
The Quick Access Toolbar appears to the right of the Office Button 
and provides easy access to the commands you use most 
frequently. By default, the Save, Undo, Redo, Previous Item and 
Next Item buttons appear on the toolbar; however, you can 
customize this toolbar to meet your needs by adding or removing 
buttons. To customize it:  

• Click the Customize Quick Access Toolbar button at the end of 
the Quick Access Toolbar and select the commands you want to 
add or remove.  

Tips  

 You can change where the Quick Access 
Toolbar appears in the program window. To 
do this, click the Customize Quick Access 
Toolbar button at the end of the Quick 
Access Toolbar. Select Show Below the 
Ribbon or Show Above the Ribbon, 
depending on the toolbar’s current location.  
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Using the Navigation Pane  
The Outlook program is made up of several sets of tools and 
folders, each with their own separate and unique screens. 
You can switch between these sets of tools by using the 
Navigation Pane.  

The Mail pane appears by default when you start Outlook, but 
you can display other panes by clicking different Navigation 
Pane buttons such as Calendar, Contacts, or Tasks.  

Switch between panes  
• Click a navigation pane button (for example, Mail, Calendar, 

Contacts, or Tasks) in the Navigation Pane.  

The selected pane appears.  

Other Ways to Switch Panes: Click Go on the menu bar and select 
the pane you want to view.  

Table 1-3: The Navigation Pane provides an overview of the contents 
of the Navigation Pane.  

Tips  

 To minimize or expand the Navigation Pane in the 
window, click the Minimize the Navigation Pane or 
Expand the Navigation Pane button at the top of the 
Navigation Pane.  

 
 
 
 
 
 

 
 Inbox - Contains all your recent incoming e-mail messages.  
 

 Unread Mail - Contains all your unread messages.  

 
 Sent Items - Stores copies of messages you have sent. 
 

 
Mailbox - Provides a preview of your day; summarizes appointments, tasks, and new e-mail messages. 

Deleted Items - Works like the Windows Recycle Bin; where you can find deleted Outlook items.  

 
Drafts - Stores draft messages that you haven’t yet completed. 
 
Outbox - Temporarily stores any messages that you’ve composed that have not been sent. 
 
Junk E-mail - Contains messages that are considered spam. Check this folder periodically for incorrectly flagged messages.  

 
RSS Feeds - Allows you to access content that you’ve subscribed to via RSS feed, such as news and blogs.  
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Provides quick access to color categorized messages, messages flagged for 
follow-up, messages with large attachments, and unread messages.  

 
Enables you to view and schedule appointments, events, and meetings.  

 
Stores addresses, numbers, e-mail addresses, and other information about people 
you contact.  

Allows you to organize and manage to-do items.  
 
Works like electronic sticky notes; allows you to jot down quick bits 
of information.  

Displays all the folders in Microsoft Outlook.  
 
Contains shortcuts (that you add yourself) to other folders, such as the My 
Documents folder.  

 
Allows you to add or remove buttons from the Navigation Pane.  
 
Records information about items you send or receive and files you create (not 
shown by default).  

Using the To-Do Bar  
The To-Do Bar is new for Outlook 2007 and 
combines a basic calendar, the day’s appointments, 
and current tasks into one pane. It allows you to 
keep tabs on multiple sources of information in 
Outlook all at once.  

Display the To-Do Bar  
• Select  View → To-Do Bar → Normal 

from the menu.  

The To-Do Bar appears on the right-hand side 
of the screen.  

Tips  

 To minimize the To-Do Bar, click the 
Minimize the To-Do Bar button, which is 
located at the top of the To-Do Bar.  

 If you click a date on the calendar in the 
To-Do Bar, the Calendar module is 
displayed on the screen.  
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Using Menus and Toolbars  
Using menus and toolbars are two good ways to give commands in Outlook. While they have been replaced by the 
Ribbon in item windows, they still remain on the Outlook 2007 program screen.  

There are also two more tools that you can use in Outlook 2007 that make relevant commands even more readily 
available: contextual menus and the Mini Toolbar.  

Menu bar  
The menu bar is located just beneath Outlook’s title bar. The menus on the menu bar include: File, Edit, View, Go, Tools, 
Actions, and Help. Within each menu is a list of related 
commands. To issue a command using a menu:  

1. Click the menu name with the mouse.  

The menu appears.  

Other Ways to Open a Menu: Press <Alt> and then the underlined letter in menu.  

2. Select a command from the menu.  

Tip: Additional submenus will appear under certain menu items.  

Toolbars  
Outlook’s toolbars provide an even faster way to give commands. By default, the Standard toolbar appears on the 
program screen, displaying buttons for issuing the most commonly used commands. To give a command using a 
toolbar:  

• Click the button on the toolbar for the command you want to issue.  

Tips  

 To display the Advanced and Web toolbars, right-click anywhere in the menu or toolbar area of the Outlook 
program screen and select the toolbar you want to display from the menu.  

 

 Toolbar buttons change depending on which folder is open. For example, when the Inbox is displayed, Outlook 
displays message-related buttons. When Calendar is displayed, appointment-related buttons appear.  

 

 To display a toolbar button’s description, point to the button and wait a second. A ScreenTip appears, telling you 
what the button does.   

 
 
 
 
 

Contextual menus  
Another type of Outlook menu, a contextual menu, displays a list of commands related to a specific object or area. To 
open a contextual menu:  

1. Right-click an object or area in the item window or program screen.  A contextual menu appears, displaying 
commands that are relevant to the object or area you clicked.  

2. Select an option from the contextual menu, or click anywhere outside the contextual menu to close it without selecting 
anything.  
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Mini Toolbar  
New in Outlook 2007 is the Mini Toolbar, which appears when you select text in a new item window, and contains 
common text formatting commands. To view the Mini Toolbar:  

1. Select text in an item window.  

The Mini Toolbar appears above the text you selected.  

Trap: Sometimes the Mini Toolbar can be hard to see due to its 
transparency. To make the Mini Toolbar more visible, use pointer to 
point to it.  

Tip: A larger version of the Mini Toolbar also appears along with 
the contextual menu whenever you right-click in an item window.  

2. Click the desired command on the Mini Toolbar or click anywhere 
outside the Mini Toolbar to close it.  
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Using Keyboard Commands  
Another way to give commands in Outlook 2007 is using the keyboard. There are two different types of keyboard 
commands in Outlook 2007: keystroke shortcuts and Key Tips.  

Keystroke shortcuts  
Keystroke shortcuts can save time when issuing 
common commands, such as creating a new mail 
message.  

In order to issue a command using a keystroke 
shortcut, you simply press a combination of keys on 
your keyboard. For example, rather than clicking the 
New button on the Table 1-4: Common Keystroke 
Shortcuts 

Standard toolbar to create a new mail message, you 
could press and hold the keystroke shortcut, <Ctrl> + 
<N>.  

Table 1-4: Common Keystroke Shortcuts 
provides an overview of commonly used 
keystroke shortcuts.  

 

Key Tips  
New in Outlook 2007, Key Tips appear whenever 
you press the <Alt> key in an item window.  

To issue a command using a Key Tip:  

1. Press the <Alt> key.   

Tiny letters and numbers, called badges, appear 
on  
the Office Button, the Quick Access Toolbar, and 
all  
of the tabs on the Ribbon.   

2 Depending on the tab or command you want to 
select, press the letter or number key indicated on 
the badge.  

3 Repeat this step as necessary until the desired 
command has been issued.  

 
 

       
      . 

<Ctrl> + <O> Opens the selected item.  

<Ctrl> + <N> Creates a new item.  

<Ctrl> + <S> Saves the currently opened 

item.  

<Ctrl> + <P> Prints the selected item.  

<Ctrl> + <B> Toggles bold font formatting.  

<Ctrl> + <I> Toggles italic font formatting.  

<Ctrl> + <C> Copies the selected text or 

object.  

<Ctrl> + <X> Cuts the selected text or object. 

<Ctrl> + <V> Pastes the selected text or 

object.  

 

 
Key Tip badge 
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Using Help  
When you don’t know how to do something in Outlook 2007, 
look up your question in the Outlook Help files. The help files 
can answer your questions and offer tips about Outlook’s 
features.  

Search for help 
1. Click the Microsoft Office Outlook Help button ( ) on 

the Standard toolbar. 

The Outlook Help window appears.  

Other Ways to Open the Help window: Press <F1> or 
type a question in the “Type a question for help” box on the 
menu bar.  

2. Type what you want to search for in the “Type words to 
search for” box and press <Enter>. A list of help topics 
appears.  

3. Click the topic that best matches what you’re looking for.  
 

Outlook displays information regarding the selected topic.  

 

Browse for help  

1 Click the Microsoft Office Outlook Help button ( ) on 
the Standard toolbar 
 

2 Click the category that you want to browse. 
The topics within the selected category 
appear.  

3 Click the topic that best matches what you’re 
looking for.  

 
Outlook displays information regarding the 
selected topic.  

 

 
 
 

 

 

 

 

 

 

 

 

 

 

Back   Click here to move back to the 

previous help topic.  

Forward Click here to move 

forward to the next help topic.  

Home Click here to return to the Help 

home page.  

Print Click here to print the current 

help topic.  

Change Font Size Click here to 

change the size of the text in the Help 

window.  

Show Table of Contents Click 

here to browse for help using the 

Table of Contents.  

Keep On Top/Not on Top Click here 

to layer the Help window so that it 

appears behind or in front of all other 

Microsoft Office programs.  

 

          Enter search    Browse help     Choose a. 
                  keywords here.  topic categories  help source 
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2  
 

This chapter covers two of the most-used functions in Microsoft Outlook: How to compose 
and send an e-mail message.  

 
The steps involved in composing and sending a message are pretty basic, but there’s quite 
a bit you can do in between these processes to maximize the effect that your messages 
have. This chapter will show you how to insert a signature, attach a file to a message, and 
more.  
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Creating/Addressing E-mail  

Creating Email  
This lesson explains how to perform the most basic e-mail 
task of all: how to compose an e-mail message.  

1 Click the Mail tab in the Navigation Pane.  

2 Click the New button on the Standard toolbar.  
 

An Untitled – Message window appears.   

 Other Ways to Create a New Message:  
Select File → New from the menu and select  
Mail Message from the submenu. Or, press  
<Ctrl> + <N>.  

 

Addressing Messages  
Type the recipient’s name or email address in the To,  
Cc and/or Bcc field(s). 

To address a message to more than one person, separate 
names with semicolons (e.g., Jane Smith; Smith, Joe; 
Sam.Hollinsworth@yahoo.org) or hit Enter after each name.  

If the recipient is in the Global Address List (WSCC’s Directory) 
or your Contacts (Personal Address Book), simply type the 
person’s name and Outlook will automatically perform a Check 
Names within seconds of your moving to the Subject line.  

To check the names more quickly, click Check Names on the 
ribbon.  

 If Outlook finds the email address, the name will be 
underlined in black. To see what address it is using, 
right-click the underlined name and then click Outlook 
Properties.  

 If Outlook finds more than one match for the name, it 
will underline the name in red. To select the person you 
want, right-click the name underlined in red.  

 If Outlook cannot find the address, the name will not 
have an underline at all.  

 
Another way to locate a person’s email address is to click the To button and search for the name. By default, Outlook 
will search in the Global Address List. To search in your Contacts, click the drop-down arrow next to the Global Address 
List and choose Contacts, which is listed under the Outlook Address Book.  

1. Type the subject of the e-mail in the Subject field. If you don’t type a subject, Outlook will warn you of this upon 
sending the message.  

2. Click inside the body area of the message window and type your message.  

3. To send the message, click Send.  
 

       

To Sends the message to the 

recipient you specify. 

Carbon Copy (Cc) Sends a copy of the 

message to a recipient who 

is not directly involved, but 

who might be interested in 

the message. 

Blind Carbon Copy (Bcc) Sends a copy of the 

message to a recipient 

without any other recipients 

knowing. To display the Bcc 

field, click the Options tab 

on the Ribbon and click the 

Show Bcc button in the 

Fields group. 
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Creating/Inserting a Signature  
A signature is a file that appears at the bottom of all your outgoing messages identifying you by your name, title, 
address, phone number, etc.   

Other things that you can include in your signature file are pictures, logos, website links, or even a confidentiality 
disclaimer.   

Create a signature  
1. In the main Outlook window, select Tools → Options from the menu. The Options dialog box appears.  
2. Click the Mail Format tab and click Signatures. The Signatures and Stationery dialog box appears. Here you 

can create new signatures and manage existing ones.  
3. Click New, enter a name for the signature, (e.g., My Signature), then click OK.  

4. In the Edit signature field, type the text that you want to appear in the signature. Then, format the signature as 
desired.  

5. Insert pictures or hyperlinks, if desired.   

6. Click Save.  

7. On the right side of the box, under Choose 
Default Signature, choose your new signature as 
the default for all New Messages and 
Replies/Forwards.  

8. Click OK.  
 

The next time you create a new message, your 
signature will appear.  

Tip: You can create more than one signature in 
Microsoft Outlook. For example, you might want to use 
one signature for professional correspondence and 
another for personal.  
Figure 2-2: The Signatures and Stationery dialog box.  
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Attaching Files to a Message  
One of the most useful features of e-mail is the ability to attach one or more files to a message. You can attach 
pictures, documents, PDFs and more in Outlook.  

1. In the Message window, click the Attach File button in the Include group. The Insert File dialog box appears.  

2. Navigate to and select the file you want to insert, and then click Insert . The selected file 
is attached to the message.  

 

Attaching Items to a Message  
You can also attach other items, such as emails, 
calendars, and contacts to a message.  

1. In the Message window, click Attach Item 
button in the Include group. The Insert Item 
dialog box appears.  

2. To attach email messages, go to the folder 
where those messages are saved (Inbox, Sent 
Items, etc.) and hold down the Ctrl key to select 
more than one.  

3. Click OK.  

4. To select other messages, click Attach Item 
again and select other messages from the 
appropriate folders.  

 

Inserting Calendars into a Message  
If you are trying to schedule a meeting with someone off campus or someone not yet on Exchange, you can insert a 
snapshot of your calendar into an email for them to view.  

1. In the Message window, click Calendar button in the Include group. The Send a Calendar via email dialog box 
appears.  

2. Select the date range and whether or not you want it to include your working hours only.  

3. Click OK.  

4. A snapshot of your calendar will insert into the email.  
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Specifying Message Options  

Request a read or delivery receipt  
If you feel like your messages are being ignored, try requesting a read receipt. That way, you can track when a recipient 
receives and reads the message.  

Trap: Read receipts only work if your recipient’s e-mail 
program supports them.   

1. In the Message window, click the Options tab on the 
Ribbon.   

2. In the Tracking group, select Request a Delivery Receipt 
and/or Request a Read Receipt.  

• Request a Delivery Receipt: Sends you a notification 
when the message has been successfully delivered.  

• Request a Read Receipt: Sends you a notification when 
the recipient has opened the message.  

 
Tip: Don’t rely too heavily on read receipts; your recipients 

have the option to deny them.  

Other Ways to Request Receipts: Click the Options 
tab on the Ribbon and click the Dialog Box Launcher in 
the Tracking group. Under Voting and Tracking options, 
select Request a delivery receipt for this message, 
Select a read receipt for this message, or both. Click 
Close.  

Other Options  
You might have noticed a variety of other message options on 
the Ribbon or in the Message Options dialog box.  

 

  

 

 

 

  

 

Sensitivity Displays a tag indicating how the 
recipient should treat the message.

Security Settings Encodes the message so it is not 
readable by anyone except the intended 
recipient(s). 

Have replies sent to Sends all replies to the message to 
someone else, such as an assistant.

Do not deliver before Waits to send the message until the date 
and time you specify. 

Expires after Makes the message unavailable after a 
specified date and time. 
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Recalling a Message  

Recall a message  
Sometimes you might forget to attach a file to a message, or accidentally send a message to the wrong person(s). When 
this happens, you can recall the message – provided the following conditions are met:  

 The recipient has not opened the message  

 You and the recipient use Microsoft Exchange  
 

1. In the main Outlook window, click the Mail button in 
the Navigation pane. The Mail pane appears.  

2. Click the Sent Items folder in the Mail pane and 
double-click the message that you want to recall. The 
message opens in its own window.  

3. On the Ribbon, click the Other Actions button in the 
Actions group and select Recall This Message. The 
Recall This Message dialog box appears.  

4. Specify your options and click OK. The message is 
recalled.  

5. If you chose to replace the recalled message with a 
new message, make your edits as necessary and 
click Send. The recalled message appears.  

6. Click the Close button to close the recalled message.  
 

To see if your recall was successful, check your Inbox for 
a notification.  
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Saving Unfinished Messages (Drafts)  
If you get interrupted while composing an e-mail message, all is not 
lost; you can save the unfinished message and return to it later.  

Save an unfinished message  
• Click the Office Button and select Save from the menu.  

Outlook saves the unfinished message to the Drafts folder.  

Other Ways to Save a Message: Click the Save button on 
the Quick Access Toolbar.  

Open a saved message  

It’s easy to return to an unfinished message.  

1. In the main Outlook window, click the Mail button 
in the Navigation Pane.  

2. Click the Drafts folder.  A list of unfinished 
messages appears.  

3. Double-click the message you want to finish.  
 
The message opens in its own window, exactly how you 
left it.   



26 | P a g e  
 

 

Using the Out of Office Assistant  
If you know that you’re going to be out of the office for a few days, it’s a good idea to set up the Out of Office Assistant. 
The Out of Office Assistant sends an automatic response 
to any messages you receive while you’re away.  

1. In the main Outlook window, select Tools → Out 
of Office Assistant from the menu. The Out of 
Office Assistant dialog box appears.  

2. Click the Send Out of Office auto-replies option 
and specify a start and stop time, if desired. Now 
you need to enter the text that will appear in your 
auto-reply.  

3. On the Inside My Organization and/or Outside 
My Organization tab(s), type your auto-reply.  

On the Outside My Organization tab, you may 
only want to have automatic replies sent to those 
in your Contacts to prevent messages going to 
spammers.  

4. Click OK.  

 

  

   
 
You can use the Out of Office Assistant to send a different reply to those
inside your organization than those outside your organization.  
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3 
 

Now that you know how to compose and send e-mail messages, you need to know how to 
receive and sort them.  

 
In this chapter, we’ll show you how to receive messages from your e-mail server and what to 
do with those messages once they appear in your Inbox. For example, you can reply to a 
message, forward a message on to someone else; flag a message for later follow-up, and 
more.
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Reading E-mail  
Any new, unread messages appear in bold and have a closed envelope icon ( ) next to them. To view a message in 
the Reading pane, click the message. To view a message in its own window, double-click the message. 

 

 You can view messages safely in the Reading pane; potentially malicious scripts or attachments are not 
activated or opened automatically.  

 All messages have one or more icons to indicate their status, importance, and contents.  

 By default, Outlook is configured to block external content, such as links to pictures or sounds, 
in HTML messages that you receive. To unblock content, click the notification area in the Reading pane and 
select Download Pictures.  

 

Deleting E-Mail 
E-mail may be deleted in the list view using DELETE or the open e-mail message itself using the X icon. There are two deletion 
methods a simple delete and a permanent delete.      

Simple vs. Permanent Delete  
A simple delete will move the e-mail message to the Deleted Items folder. The message will then need to be deleted again 
to remove it from your mailbox. The message will remain in a recoverable storage area for up to 30 days before being 
removed completely from the e-mail system.  

A permanent delete <Shift>+<DELETE> will automatically remove the message from the system completely. It skips the 
Deleted Items folder and does not store the message in the recovery storage area.  
  

Tips  
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Opening/Saving Attachments  
Whenever you see a paper clip icon ( ) next to a message, the message contains an attachment. This lesson will show 
you how to preview, open, and save an attachment. 

Open an attachment  
To open an attachment, double-click it.  

1. Click the Mail button in the Navigation pane and 
double-click the message containing the attachment. 
The message opens in its own window.  

2. Double-click the attachment that you want to open. The 
Opening Mail Attachment dialog box appears, reminding 
you that you should only open files from a trustworthy 
source. If you trust the sender of the attachment, 
continue to the next step.  

3. Click Open.  
 

Other Ways to Open an Attachment:  
In the Inbox, click the message containing the attachment 
that you want to open. Then, double-click the attachment 
in the Reading pane.  

Save an attachment  
If you’re going to be making changes to an attachment, you’ll 
need to save it to your computer first.  

1. Double-click the attachment that you want to save. The Opening Mail Attachment dialog box appears.  

2. Click Save. The Save As dialog box appears.  

3. Enter a new name for the file, if necessary, and specify where you want to save the file.  

4. Click Save.  
 

Other Ways to Save an Attachment:  
In the Inbox, click the message containing the attachment that you want to save. Right-click the attachment in 
the Reading pane and select Save As from the 
contextual menu.  

Save multiple attachments  
If you receive an email with many attachments (including 
pictures), you can save them all at once.  

1. Click the email with the attachments.  

2. Click File and select Save Attachments, then All 
Attachments.  

3. The Save All Attachments window opens. Click OK.  

4. Select the folder where you want to save the files and 
click OK.  
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Flagging a Message for Follow-up  
Flagging a message is an easy way to remind you to follow up on an 
important e-mail or task. When you flag an item, a small ( ) icon 
appears next to the message, and a copy of the message is added to 
your To-Do List.  

Flag a message  
Flagging a message is extremely easy.  

1. Click the Mail button in the Navigation pane. The Inbox 
appears.  

2. Click the Flag area of the message you want to flag.  
 

The default flag—the Today flag—is applied to the message, and a copy of the message is added to your To-Do 
List.  

Other Ways to Flag a Message:  
Select the message you want to flag, click the Follow Up button on the Standard toolbar, and select a flag 
from the list.  

Change flags  
The default flag is the Today flag, but there are several others for you to choose from.  

1. Click the message containing the flag you wish to change and click the Follow Up button on the Standard 
toolbar. A list of flags appears.  

2. Select a flag from the list.  
 

The selected flag is applied to the message.  

Other Ways to Change Flags:  
Right-click the flag you wish to change and select a 
new flag from the contextual menu.  

Set a reminder date  
You can add a reminder date to a flagged message so that 
Outlook reminds you to follow-up on the message when the 
specified date arrives.  

1. Right-click the flag you want to add a reminder 
date to and select Add Reminder from the 
contextual menu.  

The Custom dialog box appears. Here you can set a 
reminder date, change the purpose of the flag, or set a 
start and end date for the flag.  
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1. Click the Reminder Date list arrow, and select a date from 
the Calendar.  

2. Click OK.  
 

Outlook will send you a reminder to follow-up on the 
message when the specified date arrives.  

Remove a flag  
Once you’ve followed-up on a flagged message, you can 
remove the flag or mark it as “Complete”.  

1. Right-click the flag you want to remove.  

2. Select Mark Complete or Clear Flag from the contextual 
menu.  

 
Depending on the option you selected, the Flag is either 
replaced by a checkmark ( ) or removed altogether. 

Other Ways to Mark a Flag “Complete”:  
Click the flag.  

Tips  

 You can also control message flags from inside the 
Message window. To do so, click the Follow Up 
button in the Options group and select an option from 
the menu.  

 You can also flag contacts and tasks.  

 Unlike the Flag for Follow Up feature in Outlook 2003, 
you cannot color-code flags in Outlook 2007.  

 
.  
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Using Color Categories  
Color categories let you organize your Outlook items into 
specific groups, making the information they contain easier to 
distinguish. You can choose from a set of default categories, 
or you can even create your own.  

Assign a color category  
By default, you have eight color categories to choose from.   

1. Click the Mail button in the Navigation pane. The 
Inbox appears.  

2. Click the message you wish to categorize and click 
the Categorize button on the Standard toolbar. A list 
of categories appears.  

3. Select a category from the list.  
 

The selected category is applied to the message.   

Tip: You can assign multiple categories to a message.  

Other Ways to Categorize a Message:  
Right-click the message you want to categorize,  
select Categorize from the contextual menu, and  
select a category from the list.  

Clear a category  
If you decide you don’t want to categorize a message after all, you 
can clear the category.  

• Right-click the category you wish to clear and select Clear 
All Categories from the contextual menu.  

Rename a category  
You can rename Outlook’s color categories to meet your needs.  

1. Click the Mail button in the Navigation pane. The Inbox 
appears.  

2. Click the Categorize button on the Standard toolbar and 
select All Categories. The Color Categories dialog box 
appears.  

3. Click the color category you wish to rename, and click 
Rename.  

4. Type a new name for the category, and click OK when 
you’re finished.  
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Create a new category  
If none of Outlook’s default categories meet your standards, you 
can create your own from scratch.  

1. Click the Mail button in the Navigation pane. The Inbox 
appears.  

2. Click the Categorize button on the Standard toolbar and 
select All Categories. The Color Categories dialog box 
appears.  

3. Click New. The Add New Category dialog box appears. 
Here you can give the category a name, assign a new 
color to the category, or create a keystroke shortcut for the 
category.  

4. Type a new name for the category, specify any other 
options as necessary, and click OK.  

 
The new category is added to the list of categories.  

Change the Quick Click category  
You can also change the Quick Click category, or the category that 
appears by default when you click the Category area of a 
message.  

1. Click the Mail button in the Navigation pane. The Inbox 
appears.  

2. Click the Categorize button on the Standard toolbar and 
select Set Quick Click. The Set Quick Click dialog box 
appears.  

3. Click the Category button and select the category you want 
to appear by default.  

4. Click OK.  
 

Now every time you click the Category area of a message, the 
selected category will be assigned to the message by default.  

Tips  

 You can also control color categories from inside the 
Message window. To do so, click the Categorize button in 
the Options group and select an option from the menu.  
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Sorting Messages  
When your Inbox is jam-packed with messages, it can be difficult to find what you’re looking for. When this happens, try 
sorting your messages using Outlook’s arrangement options. You can sort your messages by the date they were sent, 
who sent them, and more.  

1. Click the Mail button in the Navigation pane. The Inbox appears.  
2. Select View → Arranged By from the menu. A list of available arrangement options appears. See Table 3-1: 

Arrangement Options for a description of each option.  
1. Select an arrangement from the list.  

 
Other Ways to Sort Messages: In the Inbox, click Arranged By and select an 

option from the list.  

Date Arranges messages by date, starting with today. 

Conversation Arranges messages by conversation topic.  

From Arranges messages by sender. 

To Arranges messages by recipient. 

Categories Arranges messages by assigned categories. 

Flag: Start Date Arranges flagged messages by their start date.

Flag: Due Date Arranges flagged messages by their due date.

Size Arranges messages by size, largest to smallest. 

Subject Arranges messages alphabetically by subject. 

Type Arranges messages by type.  

Attachments Arranges messages by whether or not they have an attachment. 

E-mail Account Arranges messages by e-mail account.  

Importance Arranges messages by importance. 
 

  



35 | P a g e  
 

Changing Views  
There are a variety of different ways to view the messages in your Inbox. For example, you could choose to only display 
messages that haven’t been read, or view your messages on a 
timeline. This lesson shows you how.  

1. Click the Mail button in the Navigation pane.  

2. Select View → Current View from the menu.  
A list of available views appears.  

 
3. Select a view from the list.  

 Other Ways to Change Views: In the main Outlook 
window, select Tools → Organize from the menu. 
Click Using Views and select a view from the list.   

4. You can also change the view of a folder by clicking View 
and selecting Arrange By, then selecting the column that 
you want to sort by. To remove groupings, uncheck the 
Show in Groups options on that menu.  

Messages The default view in Outlook. Displays  
the Navigation, Mail and Reading 
panes. 

Messages with Auto 
Preview 

Displays the first three lines of any 
unread messages. 

Last Seven Days Only displays messages from the past 
seven days. 

Unread Messages in 
This Folder 

Only displays messages that haven’t 
been read. 

Sent To Displays the recipient(s) of each  
message in the Mail pane.  

Message Timeline Displays the messages in your Inbox on a 
timeline. 
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4  
 

When you work at your desk for a while, papers and files can pile up into a mess. The same 
thing happens after you’ve worked with Outlook for a while—your e-mails becoming 
disorganized and harder to find.  

 
In this chapter, you’ll learn how to take control and organize your Outlook information. You’ll 
learn how to search for items, manage data in folders, and create rules that automatically 
manage your e-mails.
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Using Instant Search  
The Instant Search feature, which is new to Microsoft Office Outlook 2007, helps you find messages and other types of 
items in Outlook. Although you’re most likely to use it to search for e-mail messages, the Instant Search feature is 
accessible in Mail, Calendar, Contacts, Tasks, Notes, Folder List, and Journal as well.  

Enable Instant Search  
Before you can use the full capabilities of Instant Search, you may need to download the software from Microsoft’s Web 
site.  

Tip: If you are running the Windows Vista operating system, Instant Search is already enabled as part of 
Vista’s Windows Desktop Search feature.  

1. Start the Outlook 2007 program.  

If Instant Search isn’t already enabled, a dialog box appears that prompts you to download the Instant Search 
software.  

Tip: You need to be connected to the Internet to download Microsoft’s Instant Search software.  

2. Follow the instructions in the dialog box to download and install Instant Search.  

Find a message or item  
Instant Search is very easy to use. Simply enter keywords into the Instant Search box to find messages or other Outlook 
items that contain those keywords.  

1. Enter search text in the Instant Search box.  

It isn’t necessary to click the Search button to start 
searching—items that contain the text you entered automatically 
appear in the Search Results pane with the search text highlighted.  

Tip: If you are searching your Inbox folder in Mail, for example, 
message items will appear in the search results, but if you are 
searching the Calendar, calendar items like appointments will 
appear.  

You can also clear a search and start over.  

Click the Clear Search button.  

 Other Ways to Find an Item: Click Tools on the menu bar, point 
to Instant Search, and select Advanced Find. Enter the 
information you want to find in the Advanced Find dialog box. 
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Use recent searches  
Outlook keeps track of recent searches you’ve performed so 
you can use them again.   

• Click the Show Instant Search Pane Menu arrow, point 
to Recent Searches, and select recent search 
keywords from the list.  

Outlook searches for the keywords and returns the 
results.  

Refining a Search  
You can expand or refine a search to produce additional or 
fewer results, and you can also customize the way the 
search function works.  

Expand a search  
By default, only the selected folder is searched 
when you use Instant Search, but you can easily 
expand your search to additional folders.  

• After performing a search of the Inbox, click the Try 
searching again in All Mail Items hyperlink 
(located at the end of the results) to expand your 
search to all Mail folders.   

Other Ways to Expand a Search: Click the 
Show Instant Search Pane Menu arrow and 
select Search All Mail Items.  

Refine a search  
You can simply enter more keywords to narrow your 
search results within a folder, but with the Query 
Builder you can also add search criteria that more 
precisely narrow the scope of your results.  

1. Click the Expand the Query Builder arrow next 
to the Instant Search box. Different boxes such 
as From, Body, Subject, and To appear.  

2. Enter the terms you want to search for in each of 
the areas.  

 
You can access additional search criteria by clicking 
the Add Criteria button and selecting the criteria.  

You can once again minimize the Query Builder 
when you’re done using it.  

3. Click the Minimize the Query Builder arrow.  

Change search options  
• Click the Show Instant Search Pane Menu 

arrow and select Search Options.  

The Search Options dialog box appears. Here you can 
select or deselect options related to how items are 
indexed for search, how results are shown and 
highlighted, and which folders are searched by default.   
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Creating and Using Folders  
Outlook normally saves all your e-mail messages in the Inbox 
folder, but sooner or later you may need to expand your horizons 
and create your own folders to help organize your e-mail 
messages and other Outlook items more effectively.  

This lesson will show you how to create a new folder for storing 
and organizing your Outlook items.  

Create a new folder  
1. Click the New button arrow on the Standard toolbar and 

select Folder.  

The Create New Folder dialog box appears.  

 Other Ways to Open the Create New Folder Dialog 
Box: Right-click in the Folder List and select New Folder.  

2. Type a name for the folder in the Name box. 

3. Click the Folder contains list arrow and select the type of 
item the new folder will contain.  

 
For example, you would select Mail and Post Items if you 
were creating a new folder to hold e-mail messages.  

Next, you need to decide whether you want the folder to be 
a subfolder of another folder or not.  

4. Select a folder in the “Select where to place the folder” list 
and click OK.  

The new folder appears as a subfolder within the 
folder you selected.  

Tips  

 If you want the new folder to be on the same level as 
your other folders, make sure you select the Mailbox 
folder at the top of the list when you’re creating the 
new folder.  

Move messages between folders  
Once you set up the folders you want, you can organize your 
messages by moving them into the desired folders.  

1. Select the folder in the Folder List that contains the 
message(s) you want to move.  

Tip: To move multiple messages at once, press and 
hold the <Ctrl> key while you select the 
messages.  
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2. Click and drag the message(s) to a different folder in the Folder List.  

Other Ways to Move Messages Between Folders:  
Right-click the message(s) you want to move and select Move to Folder. Select the destination folder in the 
Move Items dialog box and click OK.  

Managing Folders  
You can reorganize your folders by renaming them, moving them, and even 
deleting them.  

Tips  

 To rename, move, or delete a folder, you need to first display either 
the Folder List or the Mail pane.  

 If a folder in the folder list has subfolders, it will have a plus symbol 
next to it. Click the plus symbol to expand the folder and view the 
subfolders. Click the minus symbol to collapse them again.  

 

Rename a folder  
1. Right-click the folder and select Rename from the contextual menu.  

2. Enter a new name and press <Enter>.  
 

Move a folder  
• Click and drag the folder to the desired location.  

If you drag a folder into another folder, it becomes a subfolder of that folder.  

 Tip: If multiple folders are at the same folder level in the folder list, they 
are  
arranged alphabetically.  

 

Delete a folder  
1. Right-click the folder you want to delete in the Folder List and select 

Delete “folder name”.  

A warning message appears, asking if you’re sure you want to delete the 
folder.  
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Creating a Rule  
A rule is a very powerful tool that helps you manage your e-mail messages by automatically performing specific actions. 
When you create a rule, Outlook takes the action specified in the rule when a message arrives in your Inbox or when you 
send a message. You can use rules too automatically:  

1. Organize your messages: For example, move all incoming messages that have the word “Picnic” in the 
Subject box to a Picnic folder.  
 

2. Create a notification: Play a certain sound when you receive an e-mail from your boss. You get the idea. 
There are a couple different ways to create a rule:  

2.1.1. By example: Create a rule based on an e-mail message. Simply select the message that contains the 
sender, subject, or recipient you want to use in the rule, and then click the Rule button on the toolbar.  

 

2.1.2. Using the Rules Wizard: You can create a rule based on a template from the Stay Organized or Stay Up 
to Date collections of templates. Or, you can start with a blank rule and let Outlook walk you through the 
entire process of creating a rule using all your own conditions and actions.  

 
First let’s look at the easiest way to create a rule—by example.  

Create a rule by example  
You can use an existing message to create a rule.  

1. Select the message you want to base the rule on and click the Create Rule button on the Standard toolbar.  

The Create Rule dialog box appears.  

Other Ways to Display the Create Rule Dialog Box:  
Right-click the message you want to base the rule on 
and select Create Rule from the contextual menu.  

2. Select condition(s) for the rule.  

Choose From, Subject, or Sent to conditions. The rule 
will only apply when you receive e-mail that satisfies all 
the conditions you select.  

3. Specify the action you want to take if the condition(s) are 
met.  

Choose from displaying an alert, playing a selected 
sound, or automatically moving the item to a specified 
folder.  

Tip: Click the Advanced Options button for even 
more condition and action options.  

4. Click OK.  

Outlook asks you to confirm the creation of the new rule.  

Tip: If you want to apply the rule to messages you’ve already received, click the Run this rule now on 
messages already in the current folder  

check box.  

5. Click OK.  

The rule is active.  
 

  

     



42 | P a g e  
 

Creating a Rule with the Rules Wizard  
The Rules Wizard can help you create a rule from a template or by starting with a blank rule.  

1. In Mail, select Tools → Rules and Alerts from the menu. The Rules and Alerts dialog box appears, displaying 
the E-mail Rules tab.  

2. Click the New Rule button.  
 

The Rules Wizard dialog box appears. The Rules Wizard 
takes you through several steps to help you establish 
your new rule.  

First you will see “Step 1: Select a template”. Here you 
can choose from templates in the Stay Organized or Stay 
Up to Date sections, or create a rule from scratch by 
selecting an option in the “Start from a blank rule” section.  

3. Select a template or blank rule option and click Next. 
Now you need to select which conditions you want to 
use.  

4. Select the condition(s) you want to check. You may 
also need to edit rule descriptions in the “Step 2: Edit 
the rule description” area at the bottom of the dialog 
box. For example, if the rule is going to play a sound, 
you need to select which sound to use.  

5. If necessary, click the underlined values at the 
bottom of the dialog box and edit the rule 
descriptions. When you’re finished, click Next in the 
Rules Wizard dialog box. Next you need to specify 
what you want to do with the messages that meet the 
specified conditions.  

6. Select the actions you want Outlook to perform. If 
necessary, define the actions at the bottom of the 
dialog box. Click Next when you’re finished.  

7. Specify any exceptions to the condition(s). If 
necessary, define the exceptions in the bottom of the 
dialog box. Click Next when you’re finished.  

8. Enter a name for the new rule and click Finish.  
 

Tip: If you want the new rule to be applied to messages 
already in the folder, select that option before you click 
Finish.  
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5  
 
Outlook’s Contacts list is a “technological Rolodex” database that keeps track of names, 
addresses, phone numbers, and lots of other information. Once you have entered a 
person’s name and details into Outlook, the possibilities are endless. You can instantly find, 
e-mail or print contact information, or even create a map to a contact’s business or home 
address.  
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Managing Contacts  

Adding a Contact  
The Contacts list contains information about people and 
organizations you interact with. The Contacts list lets you 
enter as much or as little information about your contacts as 
you want, such as their names, phone numbers, and 
addresses. You can then use the information in the Contacts 
list with the other Outlook tools.   

For example, with a few clicks of the mouse, you can send an 
e-mail to a contact or schedule an appointment with him or 
her. You can even use the Contacts list with other programs. 
For example, you could store all the information in your 
Contacts list on a Palm organizer.  

Tips  

 By default, contacts appear in Outlook in Business Cards 
view. In this view, your contacts are displayed as 
Electronic Business Cards, which look like actual paper business cards on the screen.  

1. Click the Contacts button in the Navigation pane. Outlook displays the Contacts list. Here you can see your 
contacts.  

2. Click the New Contact button on the Standard toolbar.  
 

The Untitled – Contact window appears. It’s up to you 
how much information you enter about a contact. You 
can enter the contact’s name, company, job title, e-mail 
address, Web page address, phone numbers and 
addresses.  

 Tip:  

To add a picture of a contact, click the Add Contact 
Picture button (located next to the Name and Company 
fields).  

3. Enter as much contact information as you want in the 
window.  

 Tip:  

Several of the fields in the Contact item window have 
buttons and list arrows next to them. The buttons display 
dialog boxes to assist you with the fields, while the 
arrows are used if a contact has more than one phone 
number, e-mail account, or address.  

4. Click the Save & Close button in the Actions group.  

The Contact window closes and the new contact appears in the contacts list.  
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Adding an E-mail Sender to Your Contacts   
You may receive an e-mail message from someone who you want to add to your Contacts list. To add an e-mail 
sender’s name and e-mail address to your Contacts list, simply drag the e-mail to the Contacts button in the Navigation 
Pane. Outlook will add the sender’s name and e-mail address to the Contacts list—and you can add any additional 
information yourself.  

1. Click the Mail button in the Navigation Pane. 
The Inbox appears.  

 
2. Click and drag an e-mail from the person you 

want to add to the Contacts list to the Contacts 
button in the Navigation Pane.   

 
The Contact window opens and the person’s 
name and e-mail address are filled in 
automatically.  

Other Ways to Add an E-mail Sender to 
the Contacts List:  

Open an e-mail message (or just view it in 
the Preview pane), right-click the name in 
the From line, and select Add to Outlook 
Contacts from the contextual menu.  

3. Enter any additional information for the contact.  

4. Click the Save & Close button in the Actions group.  
 

The Contact window closes. If you look in Contacts, the new contact now appears.  
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Editing and Deleting Contacts  
It’s easy to view and change information about your contacts. You can edit contact information by double-clicking a 
contact to open it in the Contact window, or you can edit information about a contact directly in the Contacts list. The 
latter method is more efficient; simply select the entry you wish to edit and make your changes.   

Edit a contact  
1. Click the Contacts button in the Navigation pane. 

Outlook displays the Contacts list.  
2. Double-click the contact you want to edit in the Contacts 

list. That person’s contact window appears.  

3. Make the necessary changes.  

4. Click the Save and Close button in the Actions group.  
 

The window closes and the changes to the contact’s 
information are saved.  

Other Ways to Edit a Contact:  
If you are using a view other than Business Cards, or 
have the Reading Pane displayed, modify the 
information right there, without opening the Contact 
window.  

Tip: You can also attach files or other Outlook items to 
contact records. Open a contact’s window, click the 
Insert tab on the Ribbon and click the Attach File or 
Attach Item button in the Include group.  

Delete a contact  
You can also delete contacts if you no longer need them.   

 Select a contact in the Contacts list and click the Delete button on the Standard toolbar.  
 

The contact is moved to the Deleted Items folder in your Mailbox.  

Other Ways to Delete a Contact: Select the contact and press the <Delete> key.  
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Changing Contact Views  
Outlook is flexible enough to keep all of your contacts in one 
place, yet display them differently depending on the type of 
work you’re doing. By default, contacts appear in Outlook in 
Business Cards view. In this view, your contacts are 
displayed as Electronic Business Cards, which look like 
actual paper business cards on the screen.  

But, like other folders in Outlook, the Contacts list has 
several different ways to look at the same information. 
These different views are very useful when it comes to 
organizing the Contacts list. You can use these views to:   

• Display more detailed information about each 
contact with fewer contacts on the screen at once 
(Address Cards and Detailed Address Cards).  

• Display more contacts on the screen at once with 
less detailed information about each contact 
(Phone List).  

• Organize and sort your contacts by their category, company, or location (By Category, By Company, or By 
Location).  

 
In this lesson, you will learn how to utilize Outlook’s views to help you sort and organize the Contacts list.  

1. Click the Contacts button in the Navigation pane.  

Outlook displays the Contacts list. 
 

2. Select the view you want to use from the Current 
View menu, located in the Navigation Pane.  

Other Ways to Change Contact Views: Display the Contacts list, click the View menu on the Standard toolbar, 
point to Current View, and select a view from the submenu.  

 

Business Cards Displays contacts as traditional business cards. This is the default view for the Contacts list. 

Address Cards Displays contacts on individual cards with one mailing address and business and home phone numbers. 

Detailed Address Cards This is the most detailed view of the Contacts list. Everything is displayed on individual cards: business 

and home addresses, phone numbers, and any other information. 

Phone List Displays contacts in a list with company name, business phone number, business fax number, and 

home phone number. Phone List View displays more contacts on the screen at a time but has less 

detailed information. 

By Category Displays your contacts in a table and organizes and sorts contacts by color category (if categories have 

been assigned to contacts). 

By Company Displays your contacts in a table and organizes and sorts contacts by company. 

By Location Displays your contacts in a table and organizes and sorts contacts by country and state. 

Outlook Data Files Displays your contacts in a table and sorts them alphabetically. 
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Working with Distribution List 
A distribution list, sometimes called a group, is an Address Book entry comprised of 
several names from the Address Book. You use distribution lists to send an e-mail 
message to every member of the group in a single mailing. You can use distribution 
lists to quickly send e-mails to:   

 All employees in the same department or organization  

 Members on the same project or committee  

 A group of friends  
 
Distribution lists show up as items in your Address Book and Contacts list the 
same way that a person’s name does. To address an e-mail message using a 
distribution list, follow the same procedures that you would with any other 
message.   

In this lesson, you will learn how to create a distribution list that you can use 
to send e-mails to multiple recipients.  

Create a distribution list  
Before you can send e-mails to recipients in a distribution list, you need to 
create the list.  

1. Click the New button list arrow on the Standard toolbar 
and select Distribution List. The Untitled – 
Distribution List window appears.  

2. Enter a name for the distribution list in the Name field.  
 

For example, you could call the distribution list  
“Family” or “Management Team”.  

Now you’re ready to choose which recipients you  
want to include in the distribution list.  

3. Click the Select Members button in the Members 
group on the Ribbon.  

The Select Members dialog box appears, giving you  
access to all of the contacts in your address book.  

4. Find and double-click the names of recipients you 
want to add to the distribution list.   

As you add recipients, their names appear in the  
Members field at the bottom of the dialog box.  

 Tip: To search for recipients in different address books—for example, the Contacts folder—click the Address Book list 
arrow at the top of the Select Members dialog box and select the desired address book.  

  
Other Ways to Add Recipients:  
Select the name of the recipient, and then click the Members button at the bottom of the Select Members dialog box.  

5. Click OK when you’re finished. You return to the Distribution List window. The name you entered for the distribution list now 
appears in the title bar and the names of the recipients are listed in the window.  

6. Click the Save & Close button in the Actions group on the Ribbon.  
 

The window closes and the new distribution list is saved.  
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Send an e-mail using a distribution list  
Once you have created a distribution list, it’s easy to send a mass e-mail to the group’s recipients. The process for 
sending an e-mail to a distribution list is the same as it is for a single recipient.   

1. Click the New button on the Standard toolbar. A new message window appears.   
2. Click the To button. The Select Names dialog box appears.  
3. Select the name of the distribution list you want to use, click the To button and click OK.  

 
You return to the message window.  

Tip: If your distribution list is rather large, or if you’d like to keep everyone’s name and e-mail address private, 
enter the distribution list into the Bcc field instead of the To field.  

4. Type your message text and click the Send button once you’re ready to send it.  

All the recipients on the distribution list will receive the same e-mail from you.  
 


